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1 INTRODUCTION 

This manual describes the operation of the Valeport MIDAS BathyPack bathymetry system, and its associated PC 

software BathyLog. 

 

The purpose of the MIDAS BathyPack is to convert pressure measurements into depth data, taking account of the local 

variations in water density to ensure the highest possible accuracy.  In addition, the MIDAS BathyPack also accepts data 

from an altimeter to provide height above the seabed, corrected using the on-board Valeport “time of flight” sound 

velocity sensor, thus giving an overall location of the device within the water column.  Whilst the concept of such a 

bathymetry system is not new, the MIDAS BathyPack builds on the standard specification you would expect with several 

unique features that significantly enhance the performance of the product: 

 

• Temperature compensated piezo-resistive pressure sensor gives ±0.01% accuracy with better stability and durability 

than a resonant quartz type.  In addition, there is no oil reservoir to protect the sensor, allowing easier maintenance 

and faster deployment. 

• Valeport’s own inductive coil conductivity sensor, constructed from advanced composite materials to eliminate the 

effects of pressure on sensor performance.  Most inductive cells distort under pressure, giving errors in the 

measurement – even a few µm is enough to put the sensor out of specification at depth.  This cell has no such 

errors.  Inductive cells also have an advantage over electrode conductivity sensors, in that they are less susceptible 

to contamination by oil, growth or debris. 

• Full "in situ" factory calibration; inductive conductivity cells are affected by the presence of any object (conductive or 

non-conductive) that lies within the sensor's field (within approx. 5cm).  Valeport's factory calibration against a 

salinometer, performed with all other sensors and guard in close proximity, guarantees in-field accuracy.  A simple 

"resistor calibration" actually does nothing more than verify sensor operation.  Further, the digital measurement 

technique virtually eliminates drift in sensor calibration, eliminating the need for “field calibration” procedures. 

• Unique “synchronised sampling” means that all sensors are sampled at precisely the same instant, not in sequence.  

This removes alias errors from the measurements. 

• Altimeter input fitted as standard; no need for upgrades – just plug in the sensor. 

• Titanium housing as standard; no corrosion issues, and a maximum depth rating of 6000m.  Note that a selection of 

pressure sensor ranges is available, so your instrument’s depth rating may be limited to less than the full 6000m. 

• Full UNESCO depth calculation for more accurate depth measurement; the system uses the standard UNESCO 

method of integrating the water density variations to calculate the depth from pressure, not the simplified method of 

just averaging the density. 

• All data is viewed and stored on a topside PC, so no dedicated control unit is required.  The intuitive BathyLog 

software allows you to setup the BathyPack, log all incoming data, and display and graph the data in real time. 

• BathyLog also accepts data from Valeport’s Modus IPS and miniIPS pressure sensors, applying the BathyPack’s 

density profile to provide an accurate pressure / depth conversion for separate devices in the same locality. 

 

In summary, the MIDAS BathyPack sets out to “de-mystify” the accurate calculation of depth from water pressure; state of 

the art sensing technology gives you accurate data; precise calculations give you accurate answers; simple PC software 

gives you total control.  Getting the right answer has never been easier. 
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2 SPECIFICATION 

2.1 SENSORS 

The MIDAS BathyPack is fitted with integral Pressure, Conductivity, Temperature and Sound Velocity sensors, and will 

accept external inputs from 3rd party digital altimeters (currently Tritech, Kongsberg or Benthos / Datasonics).  

Specifications are given here for the integral sensors and the parameters calculated from them. 

 
2.1.1 CONDUCTIVITY 2.1.2 TEMPERATURE 

Type Valeport Inductive Coil Type Valeport PRT 
Range 0 – 80mS/cm Range -5 to +35°C 
Accuracy ±0.01mS/cm Accuracy ±0.005°C 
Resolution 0.002mS/cm Resolution 0.002°C 
Stability <±0.01mS/cm/year  

  
2.1.3 SALINITY 2.1.4 DENSITY 

Method Calculation (PSS-78) Method Calculation (EOS-80) 
Range 0.02 – 42 (calculation unverified at 

higher salinities) 
Range 994 – 1075 kg/m³ 

Accuracy ±0.017 (at 500m depth) Accuracy ±0.016 kg/m³ (at 500m depth) 
Resolution 0.001 Resolution 0.001 kg/m³ 
  

2.1.5 SOUND VELOCITY (MEASURED) 2.1.6 SOUND VELOCITY (CALCULATED) 

Type Valeport miniSVS (50mm type) Method Calculation (Chen & Millero 1977) 
Range 1400 – 1600 m/s Range 1400 – 1600 m/s 
Accuracy ±0.006 m/s Accuracy ±0.25 m/s (estimated) 
Resolution 0.001 m/s Resolution 0.001 m/s 
  

2.1.7 PRESSURE 2.1.8 DEPTH 

Type Piezo-Resistive Cell Method Standard UNESCO Calculation 
Range Various, 10Bar to 600Bar Range N/A 
Accuracy ±0.01% range (~ 1cm @ 10Bar range) Accuracy See Note Below 
Resolution 0.002% range (~ 2mm @ 10Bar range) Resolution 1mm (software limited) 

 
A Note About Depth Accuracy: 

The true accuracy of the calculated Depth is a function of several parameters: 

• The accuracy of the Pressure sensor itself 

• The error in Density measurement resulting from accuracy of Conductivity measurement 

• The error in Density measurement resulting from accuracy of Temperature measurement 

• The error in Density measurement resulting from accuracy of Pressure measurement 

• The significance of the above errors in relation to the depth range, and the ambient Salinity and 

Temperature conditions. 

• The inherent accuracy of the equation used, which is estimated at 0.1m over 10000dBar 

The overall Depth accuracy therefore relates to not only how good the sensors are, but will also vary according to the 

local conditions.  For example, accuracy of Depth measurement in 500m water at 5°C and 35 Salinity will be different 

to that in 500m water at 1°C and 36 Salinity.   However, these variations are typically small, and it is therefore 

reasonable to assume that the accuracy will dominated by the accuracy of the pressure sensor and that of the 

UNESCO equation.  
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2.2 ELECTRONIC 

Power Source External Supply Only 

Input Range 9 – 30vDC 

Consumption 0.8W (BathyPack only) 

BathyPack will route external power to altimeter; ensure sufficient power is supplied to suit the 

altimeter used. 

NB: 24v external supply will be required if using a Kongsberg 1007 altimeter 

 

Data Output RS232 & RS485 fitted as standard (choice made by pin selection on connector) 

Protocol 8 data bits, 1 stop bit, no parity, no flow control 

Baud Rate User selectable from 2400 to 460800 (factory default 19200) 

Update Rate 1Hz 

Connector Subconn MCBH10F (power / comms) 

Subconn MCBH6F (to altimeter) 

 

2.3 PHYSICAL 

Dimensions 435mm x 90mmØ max (excl. connectors) 

Materials Titanium housing 

Titanium temperature sensor 

Polyurethane and ceramic conductivity sensor 

Carbon composite, polycarbonate and titanium SV sensor 

Max Depth 6000m (may be restricted by pressure sensor range) 

Weight (Air) 6kg 
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3 PRINCIPLE OF OPERATION 

The principle of the MIDAS BathyPack is quite simple.  The instrument passes real time data from its sensors to a surface 

PC running BathyLog software, which then uses the data it has collected to perform an accurate conversion of pressure 

readings into depth. 

 

The relationship between pressure and depth is not so simple though, and is a function of the water density.  More 

specifically, the water density at every single point in the water column affects the pressure depth relationship at the 

bottom of the column.  You therefore have to know the density of water at every point above the pressure sensor in order 

to accurately calculate the depth from the pressure value.  BathyLog software therefore builds an array table, or profile, 

of the water density at every single point in the water column as the BathyPack descends.  It also updates this table as 

the BathyPack ascends, or moves around in the column during the deployment.  The resolution of this profile is limited to 

a maximum of 6000 lines, which means that in 6000dBar of water pressure (approximately 6000m), it will store a Density 

value for every dBar (metre).  Greater resolution is possible at shallower depths, e.g. 0.25dBar in 1500dBar pressure. 

 

The benefit of creating and storing this density profile on PC, as opposed to storing it in the instrument itself or simply in 

a dedicated display unit, is that we can take advantage of the PC processing power to perform the Pressure / Depth 

calculations correctly, rather than using an approximate method.  Historically, it has been common practice to just take 

an average of the Density readings throughout the profile, and use that to convert Pressure into Depth.  However, the full 

UNESCO formula uses a Density integration function rather than Density averaging, and therefore properly accounts for 

the compressibility of water.  In water depths of less than 100m, this distinction is negligible - less than 1mm - but the 

error due to use of the more simple averaging method increases dramatically at greater pressures, approaching 1m at 

1000m depth. 

 

The second advantage of using a PC to store the Density Profile and to perform the Pressure / Depth calculation, is that 

the data may be made easily available to other devices.  Specifically, BathyLog software will also accept pressure 

readings from Valeport miniIPS and Modus IPS Pressure sensors, and use the same Density Profile to convert their 

readings into accurate Depth data.  This is particularly useful where multiple points within the same locale need to be 

monitored, saving greatly on both equipment and deployment cost. 
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4 BATHYLOG SOFTWARE 

BathyLog software has been created to perform all the functions traditionally associated with a dedicated topside display 

unit, allowing all data to be easily displayed and logged on a standard PC.  BathyLog is supplied free of charge with each 

MIDAS BathyPack instrument. 

 

Note that in addition to displaying and logging the data, BathyLog performs all the calculations required to generate an 

accurate pressure / depth conversion.  The results of these calculations may also be applied to other pressure sensor 

devices such as the Valeport Modus IPS and miniIPS products operating in the same locality, and whose outputs are fed 

into the same PC.  Further, all data is available for output on a separate serial port for other devices and packages. 

 

4.1 INSTALLING BATHYLOG 

BathyLog software is supplied on a CD-ROM with the MIDAS BathyPack; it is compatible with all versions of Windows 

from 98 onwards.  As with all software, a more powerful PC will ensure better performance, but as a minimum we 

recommend the following specification: 

 

Processor: 500MHz 

RAM: 512Mbyte 

Drive Space: 50Mbyte 

Display: 1024 x 768, 16 bit colour. 

Serial Ports: 1 x 9 pin serial port (additional ports may be required for additional functionality) 

 

As an alternative, Valeport offer a 19” rack mount PC, configured specifically for and only operating BathyLog software. 

 

If you are installing BathyLog on a PC running Windows NT, 2000, XP or Vista, please ensure that you have full 

administrator rights.  The installation process will attempt to place some files into the Windows System directory, which 

may be protected from non-administrator users.  This may result in an unsuccessful installation. 

 

Place the BathyLog CD in the CD drive of your PC.  The installation process should begin automatically, but if it does 

not, use Windows Explorer to locate the setup.exe file on the CD, and run it manually. 

 

Follow the on-screen instructions to complete installation of BathyLog, which will be placed by default in the directory 

C:\Program Files\BathyLog 

 

The program may be run by clicking the              icon on your desktop. 
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4.2 USING BATHYLOG FOR THE FIRST TIME 

When opened for the very first time, BathyLog will immediately show the following “blank” screen. 

 

 

This background page is effectively a blank canvas onto which the user may create their own preferred data display 

format, using the range of display types available.  These are described in Section 5. 

 

On subsequent occasions, BathyLog will open with the same display in place as when the program was last closed. 
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4.3 SETUP 

If the device is being used on a new deployment it is likely that some settings will 

need to be altered for correct operation.  To access the instrument setup page, 

simply use the mouse to select “Setup” from the “Display Type” menu as illustrated.  

 

 

 

 

The following screen will appear: 

 

This screen controls the setup of all MIDAS BathyPack operating parameters, together with communications protocols for 

additional Modus IPS or miniIPS pressure devices. 

 

4.3.1 PARAMETER 

BathyLog will handle up to 7 separate “devices” which are as follows: 

• MIDAS BathyPack 

• Data Output Port 

• Modus IPS or miniIPS (x4) 

• Atmospheric Pressure sensor 

 

If the device is checked under the “Parameter” heading, then BathyLog will attempt to accept (or output) data for that 

device.  If the relevant box is not checked, then it will be ignored, even if there is actually data available.  In addition, it 

will not be possible to alter any settings for a device unless it is checked. 

 

In the above example, only the check box for the BathyPack itself is checked; only data from this device will be available. 
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4.3.2 COMMS 

For each enabled device select whether communications are via RS232 or RS485.  Note that 

RS232 should only be selected if the communications link is RS232 or full duplex from the PC all 

the way to the instrument.  If an RS485 adaptor is being used to allow communications over a long 

cable length, then RS485 should be selected, even though the adaptor will actually use RS232 

communications to the PC. 

 

This is because Valeport uses a half-duplex RS485 method, where the same wire pair is used to both transmit and 

receive data.  For this reason, both the instrument and the PC must allow a short delay between transmitting and 

receiving data; such a delay is not necessary for normal RS232 communications. 

 

4.3.3 ADDRESS 

Devices operating on a multi-drop cable (for example, multiple miniIPS devices) must be 

assigned a unique address.  Click in the “Address” cell for the appropriate instrument, 

and either type the required address number (1 to 99) or use the up/down arrows to 

select a value. 

 

4.3.4 COM PORT 

For each enabled device, select the Communications Port to which the device is 

connected.  Note that each RS232 device should be assigned a dedicated port, and that 

all addressed instruments using a single RS485 adaptor should be assigned to the 

same port.  Only available ports are listed. 

 

4.3.5 BAUD RATE 

The communications chip in the MIDAS BathyPack is capable of baud rates from 2400 to 460800.  

When choosing a baud rate it is important to consider the length of the cable and the quantity of 

data that is being transmitted; it is also worth noting that only specialist high quality PC serial 

ports will be capable of achieving the highest baud rates.  Generally speaking, a baud rate of 

19200 (which is the factory default) will allow RS232 communications over 100m cable with no 

problems.  For longer cables, use a lower baud rate. 

 

Multi-drop devices using RS485 communications through the same serial port (i.e. through an 

RS485 / RS232 adaptor) must use the same baud rate; the standard IPS RS485 Controller unit 

from Valeport requires a baud rate of 38400. 

 

4.3.6 INTERRUPT 

Once the correct Com port settings have been chosen, apply power to the instrument, and click the Interrupt 

button (illustrated).  The software will now try to establish communications with the BathyPack or IPS.  
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4.3.7 STATUS 

The right hand side of the Setup display features a column labelled "Status".  This column will indicate the current status 

of each device, according to the following convention: 

 

N/A Device not enabled 

Waiting Device enabled, no data yet received 

Interrupted Communications established with device to alter setup 

<Data> If the device is operational and outputting data, it will be indicated in this column 

 

4.3.8 TARE & ATMOS SETTINGS 

The pressure sensor in the BathyPack is an absolute sensor, that is to say it measures the full pressure acting on it, 

including atmospheric pressure.  Since the Pressure / Depth conversion algorithm assumes that the Pressure is just 

pressure of water, it is desirable to remove the atmospheric pressure value from the raw sensor value before conversion.  

BathyLog offers 2 methods of doing this: 

 

Tare This method takes a single reading from the pressure sensor as it sits at atmospheric pressure, and subtracts 

this value from all subsequent data points.  This function may be implemented in a variety of ways. 

 

Atmos A Valeport IPS sensor measuring atmospheric pressure continuously may be interfaced to the software, and 

the readings from this may be subtracted from the sensor reading.  This function may be switched on or off via 

a checkbox (provided the “Atmospheric” sensor input is enabled). 

 

These functions may be implemented in various combinations, as discussed in the table below: 

Tare & Atmos Settings Notes 

 

No adjustment made to the raw pressure data.  Depth readings will therefore over-read 
by approximately 10m water. 

 

A measurement of atmospheric pressure is made by the BathyPack, and subsequently 
subtracted from all readings.  The Tare should be carried out at sea level, with the 
instrument in the same orientation as it will be deployed.  Note that this method does not 
account for subsequent variations in atmospheric pressure through the deployment. 

 

The system will continue to use the Tare value that was previously 
set.  This value and the time and date on which it was taken are 
indicated at the bottom of the screen.  This may be useful for data 
consistency on a series of short deployments. 

 

 

Data from the atmospheric pressure sensor (if available) will be subtracted from the raw 
data.  Note that differences in sensor range and accuracy may result in the BathyPack 
data being not exactly zero at sea level, but this variation will remain consistent (within 
tolerance) as changes in atmospheric pressure are accounted for. 

 

The most desirable setting.  Real time atmospheric pressure readings are subtracted 
from the BathyPack data, and a Tare function is used to adjust the data to read zero at 
sea level.  This will ensure that the calculated depth data from the system will be 
accurate as possible. 

 

The system will remove atmospheric pressure values in real time, but will continue to use 
the Tare value that was previously set.  This value and the time and date on which it was 
taken are indicated at the bottom of the screen.  This function should be used with care, 
ensuring that the Tare value previously set is still applicable. 



© Valeport Limited 2007 

MIDAS BathyPack Operating Manual Page 12 0608800b.doc 

4.3.9 CLOCK SETTINGS 

The MIDAS BathyPack’s internal clock may be set to the same time as the PC by clicking the 

“Set Time” button.  

 

 

4.3.10 DENSITY ARRAY 

The Density Array function is key to the operation of the BathyLog software.  These two 

settings should be used set the resolution of the Density Array; set the maximum operating 

depth of the current deployment, and the required array resolution, both in dBar (approx 1m) 

- the array may contain up to 6000 lines of data.  Please refer to Section 3 for an explanation 

of the function of the Density Array. 

 

4.3.11 ALTIMETER 

4.3.11.1 Type 

The MIDAS BathyPack is currently able to accept data input from Tritech, Kongsberg or Benthos / 

Datasonics digital altimeters, or mimics of their outputs.  Simply select the appropriate type.  If no 

altimeter is connected to the BathyPack, then this setting has no function. 

 

4.3.11.2 Offset 

It is common for an altimeter to be positioned above the lowest point of the vehicle to which it is 

fitted.  Enter a value (in metres) in the Offset box that equates to the distance between the 

altimeter and the bottom of the vehicle.  This value will be subtracted from any altimeter data, 

therefore giving distance below vehicle, rather than distance below sensor. 

 

4.3.11.3 SV Value 

The reading from an altimeter is dependent on the speed of sound in the water, which is itself a function of Salinity, 

Temperature and Pressure.  An altimeter can only therefore give truly accurate data if the output is adjusted to account 

for the local sound speed conditions.  BathyLog assumes that the altimeter itself is set to use a standard SV value of 

1500m/s, and will adjust the reading according to the settings in this box.  This drop-down box had three options: 

a) Fixed value (default 1500m/s).  BathyLog will adjust the altimeter readings for a fixed sound speed 

entered by the user. 

b) Calculated.  BathyLog will use Chen & Millero (1977) to calculate the sound velocity at the current 

position from the Conductivity, Temperature and Pressure sensors, and will correct the altimeter 

reading using that value. 

c) Measured.  BathyLog will correct the altimeter readings using the sound speed measured by the 

integral Valeport time of flight SV sensor.  This is the most accurate method, and is the one we 

recommend. 



© Valeport Limited 2007 

MIDAS BathyPack Operating Manual Page 13 0608800b.doc 

4.3.12 LATITUDE 

Accurate conversion of pressure to depth is dependent on local gravity, which is primarily a 

function of the operating latitude.  Enter the latitude (using decimal fractions of degrees) in the 

box illustrated.  

 

4.3.13 MAX VIEWABLE DATA POINTS 

BathyLog software generates and stores a large amount of data.  In order to simplify some of the displays, particularly 

graphical displays, it may be desirable to limit the amount of data shown at any one time.  This box allows the user to set 

such a limit – in this example 3600 points equates to 1 hour of data (update rate is 1Hz).  Data older than one hour will 

be retained in saved data files, but will no longer be shown on the data displays in real time.  The purpose of this feature 

is two-fold: 

 

a) to allow simplified data viewing in real time 

b) to conserve PC RAM for other applications 

 

There is no maximum value for this figure. 

 

4.3.14 IPS SAMPLING RATE 

Valeport Modus IPS and miniIPS sensors may be set to provide data at a choice of rates using this 

drop down menu.  The maximum rate is 4Hz (i.e. 250ms update), but it is suggested that an update 

rate of 1Hz (1000ms) is most sensible, matching the update rate from the BathyPack itself.  

 

 

 

4.3.15 SET 

Once all the settings have been made as necessary, simply click the “Set” button to confirm any 

changes in the instrument itself.  

 

Note that it is particularly important to interrupt and set any Modus IPS or miniIPS sensors on first deployment, since they 

may have been previously utilised in another application and therefore configured in a manner inappropriate for use with 

BathyLog software.  Interrupting and Setting these sensors will therefore ensure that they function correctly within this 

application. 

 

4.3.16 RUN 

Finally, when all sensors have bee set as required, simply click the “Run button” to begin sampling each 

sensor.  Note that when running, data should appear in the Status bar for each sensor. 
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5 DATA DISPLAY FUNCTIONS 

When the BathyPack is first enabled and Run, the software will show the default Valeport data display screen: 

 

This screen is presented simply to indicate the variety of display types available – each window may be sized, closed or 

changed as required by the user, to suit their own preference. 

 

5.1 SIMPLE DISPLAY 

The Simple Display gives the latest reading of any single 

chosen parameter, and is therefore best used for viewing 

real time data.  Select “Simple Display” from “Display 

Type” menu, and this box will appear: 

 

 

 

Using the mouse, Right-click in the display box to show the 

options for this display type. 

 

Firstly, you must choose which parameter you want to 

display.  Click “Sensor List”, and the available parameters 

will be displayed.  Choose the parameter of interest – 

Temperature in this example. 
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The box will now display the most recent data value from 

that parameter, updating as new data is received.  

 

This box may be moved around the screen, and the size 

changed by dragging the corners.  The text will 

automatically adjust to the largest size that can fit in the 

box. 

 

In order to improve the visibility of this display, you can change the properties of the text and the background to suit your 

preference. 

 

5.1.1 CHANGING BACKGROUND 

To change the background colour, right click in 

the box and select “Background”, “Select Color” 

as shown: 

 

 

 

 

The display shown below will appear: 

 

Select your desired colour from those available, and click OK. 

 

 

The display background will now appear in 

your chosen colour:  
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5.1.2 CHANGING FONT 

To change the style and colour of the 

text, right click in the box, and select 

“Font”, “Select Font” as shown: 

 

 

 

The following display will appear:  

 

Choose your preferred Font and colour as shown.  Do not adjust the size, since it will automatically fill the available 

space anyway. 

 

Then Click “OK”.  Your display will be given in 

your chosen Font. 

 

 

 

 

 

If the Font does not automatically adjust to fill the box, simply adjust the size of the box minutely to force the text to 

expand. 

Note:  When changing Fonts and Backgrounds, it is sensible to choose colours that have a high contrast to enable the 
display to be easily read. 
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5.2 SCROLL DISPLAY 

The scroll display is a tabular list of the data, and is suitable for showing either real time data, or data from a saved or 

uploaded file. 

 

 

The Scroll window initially appears as shown:  

 

 

 

 

 

 

 

 

 

Right – click in the Window, and select the parameter you wish 

to view from the “Sensor Lists”.  Note that you can repeat this 

process to add parameters to the scroll window 

 

 

 

 

 

 

 

 

The final Scroll Window will look something 

like this. 

 

 

 

 

 

 

 

 

The following points should be noted about the Scroll Window: 

• The most recent data point is at the top of the list, the oldest at the bottom 

• Large data files may take a few seconds to open with this display 

• The columns widths are adjustable using the mouse 

• The entire display may be positioned and resized using the mouse 

• Background colour and Font may be adjusted as with the Simple Display 
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5.3 GRAPH DISPLAY 

BathyLog will show a Time Series Graph of any chosen 

parameter, from either saved data files or as it is 

received in real time. 

 

Choose “Graph Display” from the “Display Type” menu 

and this screen will appear:  

 

 

 

 

 

 

 

Right – click the box and choose the required parameter 

from the Sensor Lists, as shown.  

 

 

 

 

Repeat to add more parameters to the same graph, 

which will be shown in a different colour, and on 

individual axes, as shown below: 

 

 

 

The Graph Window may be moved and sized using the mouse.  By default, the graph scales will “Autoscale” to fit the 

displayed data.  Control of this feature and other graph functions are described in Section 5.9. 
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5.4 BATHY GRAPH DISPLAY 

BathyLog will display data as a Profile, i.e. plotting each 

parameter against Depth rather than against Time.  This 

type of display is suitable for use with either recorded data 

files or with real time data. 

 

Choose “Bathy Graph Display” from the “Display Type” 

menu and this screen will appear:  

 

 

 

 

 

 

 

Right – click the box and choose the required parameter 

from the “Sensor List”, as shown.  

 

 

 

 

 

 

 

 

 

 

 

Repeat to add more parameters to the same graph, which 

will be shown in a different colour, and on individual axes, as 

shown: 

 

The Bathy Graph Window may be moved and sized using 

the mouse.  By default, the graph scales will “Autoscale” to fit 

the displayed data.  Control of this feature and other graph 

functions are described in Section 5.9. 
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5.5 POSITION GRAPH 

Select Position Graph from the Display Type menu, and the following graphical display will appear: 

 

This display features two traces – the Depth 

of the BathyPack, and the total water depth, 

calculated as the sum of the BathyPack 

Depth and the reading from the altimeter.  

This is a time series plot, giving a visual 

indication of the proximity of the vehicle (red 

trace) with respect to the bed (green trace). 

 

As with other graphical display types, the 

Position Graph Window may be moved and 

sized using the mouse.  By default, the graph 

scales will “Autoscale” to fit the displayed 

data.  Control of this feature and other graph 

functions are described in Section 5.9. 

 

 

 

5.6 LAST DATA DISPLAY 

The Last Data Display is a simple tabular display of the last 

piece of data received for each parameter.  It is suitable for 

use with real time data.  Initially the screen will appear as 

indicated:  

 

 

 

 

 

Right click the mouse in the box to select the required 

parameters from the “Sensor List”, repeating the 

process to add more sensors.  

 

 

The following points should be noted about the Last Data Window: 

• The QA box is a crude indication of data validity, showing green if data is OK, or Red if the software detects 

abnormal readings.  This judgement is based on the calculated Salinity of the water, which will be outside 

normal ranges if one of the sensors has malfunctioned. 

• The columns widths are adjustable using the mouse 

• The entire display may be positioned and resized using the mouse 

• Background colour and Font may be adjusted as with the Simple Display 

 



© Valeport Limited 2007 

MIDAS BathyPack Operating Manual Page 21 0608800b.doc 

5.7 SCALE DISPLAY 

The Scale Display is particularly useful when BathyLog is being used with multiple IPS sensors, allowing the relative 

position of each sensor with in the column to be seen. 

 

Select Scale Display form the Display Type menu, and 

the following window will appear: 

 

 

Right – click the box and choose the required 

parameters from the “Sensor List”.  Calculated Depths 

from the BathyPack and the IPS sensor may be shown 

on separate lists. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The scale display will indicate the relative positions of the sensors as shown: 

 

As with other graphical display types, the Scale Display may be moved and sized 

using the mouse.  By default, the graph scales will “Autoscale” to fit the displayed 

data.  Control of this feature and other graph functions are described in Section 5.9. 
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5.8 DEPTH SCROLL 

The Depth Scroll Window is effectively the Array data that BathyLog creates for each point in the profile, at the defined 

resolution.  This Array (previously referred to as a Density Array) actually contains data for all parameters at each depth; 

the Depth Scroll window may therefore be used to view the value of any particular parameter at any depth within the 

profile. 

 

 

 

Select Depth Scroll from the Display Type menu: 

 

 

 

 

 

 

 

 

 

 

Add parameters to this display by right 

clicking, and selecting the required sensors 

from the Sensor Lists. 

 

 

 

 

 

 

 

 

 

 

The following points should be noted about the Last Data Window: 

• The columns widths are adjustable using the mouse 

• The entire display may be positioned and resized using the mouse 

• Background colour and Font may be adjusted as with the Simple Display 
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5.9 GRAPH AND PROFILE DISPLAY FEATURES 

5.9.1 ZOOMING 

A particular Section of the graph may be “zoomed in” for closer viewing by simply drawing a box with the mouse over the 

area of the graph of interest.  Draw the box from top left to bottom right. 

 

 

To zoom out, simply draw a box with the mouse from bottom right to top left, 

anywhere in the graph window 

 

 

 

 

 

 

5.9.2 ADJUSTING SCALE 

By default, the scale for each parameter will “Autoscale” to suit the range of data being displayed.  However, it is possible 

to manually control the scale if preferred. 

 

Right click on the scale to be adjusted – click on the actual line of the scale as shown. 

 

 

 

 

 

Then, enter the required minimum and maximum values for the scale, and click OK. 

 

To return to the Autoscale mode, simply click “Auto”.  
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5.9.3 EXPORTING GRAPHS 

The image of a Graph or Profile may be made available to other packages, for use in presentations and reports.  Right 

click the Graph and select the “Chart Option”, then choose to either “Copy” the image to the PC clipboard for simple 

pasting, or “Save” it to disk as a bitmap or metafile image. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.10 SAVING YOUR DISPLAY 

Having decided on which types of data display you require, it is possible to arrange them on the screen by moving and 

resizing them as appropriate.  An example of how the screen could look is shown here:  
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Having finalised your design, it is possible to save it for future 

use as one of 5 “User Displays”.  Click “User Display” on the 

menu bar, then choose the appropriate User Display Number, 

and finally “Save”.  The screen format will be recorded 

accordingly.  

 

Note that you cannot overwrite the default Valeport Display 

format. 

 

 

 

 

To call up a previously saved display format, simply select the 

appropriate User Display, and “Load”.  Note that it may take a 

few seconds to load all the data into the various displays. 
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6 DATA HANDLING 

6.1 INCOMING DATA 

6.1.1 SAVING DATA 

Incoming data from the BathyPack or other sensors may be saved to disk.  To begin 

saving data, simply click 2Save Data File” from the File menu as indicated: 

 

 

 

A standard Windows “Save As” window will appear: 

 

The default file name is the date (yyyymmdd), followed by 

the instrument serial number (25830 in this example).  The 

file extension is .btd, which may not be changed. 

 

 

 

 

 

 

 

 

All incoming data from this point on will be appended to the chosen data file.  To stop 

saving data, simply click “Stop Saving Data” from the File menu: 

 

 

 

 

6.1.2 OPENING DATA FILES 

To open an existing data file, select “Open Data File” from the File menu, navigate to 

your chosen *.btd file, and open.  The data may take a few seconds to load, but will 

subsequently be available for display in all appropriate display screens (see Section 5). 

 

 

Note that while a data file is being viewed, real time data will not be shown by BathyLog. 

 

 

 

To close the data file and return to real time data viewing, select “Real Time Display” 

from the File menu.  Note that any previous unsaved real time data will be lost. 
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6.2 DENSITY ARRAY DATA 

6.2.1 SAVING ARRAY FILES 

The Density Array is a table of data calculated from the real time data coming in from the BathyPack, and it is used to 

convert pressure data into depth.  The table is dynamic, updated with real time data coming in from the BathyPack, but at 

any point during the deployment, the Array may be saved to disk.  The primary purpose of doing this would be to capture 

the Density profile at a given location to use in future pressure / depth conversions at the same location (if a BathyPack 

were not available at the time). 

 

To capture the Density Array at any given instant, select “Save SVA File Now” from 

the file menu:  

 

 

 

 

 

Enter a suitable file name and save the 

SVA file in your chosen location.  We 

would recommend choosing a file name 

to reflect the date, time and location of 

the data. 

 

 

 

 

 

 

 

 

 

 

 

6.2.2 OPENING ARRAY FILES 

To open an array file, typically so that you may use existing BathyPack data to convert 

pressure into depth for a Valeport IPS sensor, click “Open SVA File” from the File 

menu.  Navigate to the chosen SVA file, and click Open. 

 

 

 

 

Note that an opened SVA file will “over-write” any data in the real-time Density array, so this function should be used with 

care if a BathyPack is being used to collect a profile at the time. 
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6.3 DATA OUTPUT FORMAT 

One of the functions of the BathyLog software is to provide a real time data output on 

a spare PC serial port, for input to other packages, or to provide a backup data 

storage capability.  To enable this function, simply check the “Output Port” box in the 

setup screen (refer to Section 4.3).  Choose the correct Com Port on which you wish 

to output the data, and the desired baud rate. 

 

The data output string is a long string of tab separated data in ASCII text format.  The full string is as follows: 

 

Date<TAB>Time<TAB>Conductivity<TAB>Pressure<TAB>Temperature<TAB>Altimeter<TAB>SV Measured<TAB>SV 

Calculated<TAB>Depth<TAB>Total Depth<TAB>Point Density<TAB>Density Profile<TAB>Salinity<TAB>Barometric 

Pressure<TAB>IPS 1<TAB>IPS 2<TAB>IPS 3<TAB>IPS 4<TAB>IPS 1 Depth<TAB>IPS 2 Depth<TAB>IPS 3 

Depth<TAB>IPS 4 Depth<TAB><CR><LF> 

 

Parameter Format / Notes 

Date dd/mm/yyyy 

Time hh:mm:ss (24 hour clock) 

Conductivity Real time data from BathyPack in mS/cm 

Pressure Real time data from BathyPack in dBar 

Temperature Real time data from BathyPack in °C 

Altimeter Real time data from accessory altimeter (if fitted) in metres 

SV Measured Time of flight Sound Velocity data from BathyPack in m/s 

SV Calculated Sound Velocity calculated by BathyLog from CTD parameters using Chen & Millero, in m/s 

Depth Actual Depth of BathyPack in metres, as calculated by BathyLog software 

Total Depth Total water depth in metres, calculated by BathyLog as sum of Actual Depth and Altimeter 
output (if fitted) 

Point Density Theoretical Density value (kg/m³) from EOS80 formula, calculated by BathyLog 

Density Profile Actual Density (kg/m³) taking into account the integrated density variations in the water column 

Salinity Salinity value of the water, calculated by BathyLog using PSS78 formula (no units) 

Barometric Pressure Real time data from dedicated Air Pressure sensor, if available (mBar) 

IPSn Actual Pressure in dBar from an accessory mini or Modus IPS sensor, if fitted (up to 4 max)  

IPSn Depth Actual Depth in metres from accessory sensor, calculated by BathyLog using the Density profile 
from the BathyPack itself. 

 

Note: If a sensor is not fitted or available, then parameters from that device will not be included in the string 
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7 WIRING DETAILS 

7.1 BATHYPACK MAIN BULKHEAD CONNECTOR 

10 Way Female 
Subconn MCBH10F Function 

1 Power Ground 
2 Power +V 
3 RS422TxA 
4 RS422TxB 
5 RS422RxA 
6 RS422RxB 
7 RS232 Tx (To PC) 
8 RS232 Rx (From PC) 
9 RS232 Ground 
10 N/C 

 

Note:  For half-duplex RS485 communications link Pin 3 to Pin 5, and Pin 4 to Pin 6 in signal cable. 

 

7.2 BATHYPACK ALTIMETER BULKHEAD CONNECTOR 

6 Way Female  
Subconn MCBH6F FUNCTION 

1 Sensor Power Ground / RS232 Ground 
2 RS232 Rx In to BathyPack 
3 RS232 Tx Out of BathyPack 
4 Sensor Power (+24V max) 
5 RS485B 
6 RS485A 

 

 

 

7.3 RS232 3M Y LEAD (AS SUPPLIED) 

10 Way Male 
Subconn MCIL10M 3m Cable 1m Power 

Cable 
4mm Banana 

Plugs 
1m Data 

Cable 
9 Way D 

Type Function 

1 WHITE  BLUE BLACK Power Ground 
2 PINK BROWN RED 

  
Power +V 

3 N/C    
4 N/C    
5 N/C    
6 N/C    
7 GREY YELLOW 2 RS232 Tx (To PC) 
8 BLUE BLUE 3 RS232 Rx (From PC) 

GREEN  GREEN 5 (link to 
1,6,8,9) 9 

SCREEN SCREEN SHELL 

 
RS232 Ground 

10 YELLOW 

  

  Link to RS232 Ground 
 

 


